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Отчет по лабораторной работе выполняется на листах формата А4, каждый лист, кроме первого нумеруется. Все страницы отчета должны содержать рамку: всерху, справа, снизу отступ - 0,5 см., слева - 2 см. В правом нижнем углу каждой страницы должен быть угловой штамп (высота 15 мм, ширина 10 см), разделенный на два прямоугольника. Верхний (высота 7 мм) содержит надпись Лист, нижний (высота 8 мм) – номер листа. 
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Постановка задачи

Цель работы:
Освоить технологию создания сложных Web-страниц, с использованием таких элементов как фреймы, формы, карты изображений, CGI.
Постановка задачи:
Создать Web-страницу в редакторе Microsoft FrontPage “Электронный гипертекстовый учебник” по дисциплине “Сети ЭВМ и телекоммуникации”.
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1 Теоретические предпосылкиЛист


Программа Microsoft FrontPage  предназначена для быстрого создания Web-сайтов. Ее приобретение избавляет от сложностей построения сайтов с использованием языка HTML (Hyper-Text Markup Language), основного языка разметки среды Web. При  ее использовании можно работать только с несложным меню и набором команд, которые схожи с другими командами из программ Microsoft, таких как Word, Excel, PowerPoint.

1.1 Фреймы

Одно из больших преимуществ создания страниц на основе фреймов состоит в том, что можно формировать навигационные гиперссылки ко всем частям сайта. При этом содержание одного из фреймов может оставаться неизменным даже тогда, когда посетитель прокручивает содержимое основного фрейма. Благодаря этому посетители легко ориентируются на сайте, без труда переходя к разным его частям. 
Тем не менее, у фреймов есть несколько недостатков. Заголовок страницы остается одним и тем же, даже когда посетители перемещаются от фрейма к фрейму, что приводит к разного рода недоразумениям. Посетители не могут сделать закладку на конкретном фрейме в своих Web-броузерах, получая вместо этого ссылку на домашнюю страницу сайта. Один из методов решения этих проблем состоит в использовании навигационных панелей, сохраняющих свободу передвижения по сайту.
Для создания фреймовой страницы необходимо:
1) Перейти в окно просмотра страницы, затем выбрать в меню пункты File => New => Page or Web (Файл => Создать => Страница или Web).
2) В появившейся области задач щелкнуть по ссылке “Page Templates” (Шаблоны страниц).
3) В открывшемся диалоговом окне “Page Templates” (Шаблоны страниц) выбрать вкладку “Frames Pages” (Фреймовые страницы). Использовать закладку “Preview” (Предварительный просмотр) диалогового окна, чтобы выбрать шаблон фреймовой страницы, затем нажать на кнопку ОК. Появится основанная на этом шаблоне пустая фреймовая страница, которая в каждом из своих фреймов предлагает два варианта: “Set Initial Page” (Установить исходную страницу) и “New Page” (Создать страницу).
4


4) Чтобы связать фрейм с существующей на Web-сайте страницей, необходимо щелкнуть по кнопке “Set Initial Page” (Установить исходную страницу). В появившемся диалоговом окне “Insert Hyperlink” (Добавление гиперссылки) - перейти к той странице, с которой работать, и нажать кнопку ОК. Страница появится во фрейме. Чтобы создать для фрейма новую пустую страницу необходимо нажать “New Page” (Новая страница). Внутри фрейма появится пустая страница, основанная на шаблоне “Normal” (Обычный). Теперь можно разместить в этом фрейме любую информацию.
5) Нажать клавиши Ctrl+S, чтобы сохранить новый фрейм и фреймовую страницу. Если создана новая страница для какого-либо из фреймов, то фрейм этой страницы будет выделен в области предварительного просмотра диалогового окна “Save As” (Сохранить как).Лист

6) Дать новой странице имя и заголовок, отличные от уже существующих на сайте, и затем нажать кнопку “Save” (Сохранить). Новая страница будет сохранена, после чего появится диалоговое окно “Save As” (Сохранить как) для сохранения фреймовой страницы целиком (в окне предварительного просмотра эту страницу будет окружать широкая синяя рамка).
7) Дать фреймовой странице имя и заголовок, отличные от уже существующих на сайте и нажать кнопку “Save” (Сохранить). Фреймовая страница будет сохранена.
Уже создав фреймсет по одному из шаблонов фреймов, можно, к примеру, сообразить, что в нем явно не хватает еще одного фрейма. Исправить дело можно двумя различными способами: через меню “Frames” или с помощью клавиатуры.
В первом случае необходимо перейти в режим редактирования страницы, щелчком кнопки мыши выбрать фрейм, который необходимо разделить. При этом страница этого фрейма будет выделена цветным контуром. Затем выбрать в команду Frames => Split Frame (Фреймы => Разбить фрейм). На экране появится диалоговое окно “Split Frame” (Разбить фрейм). 
В диалоговом окне “Split Frame” (Разбить фрейм) необходимо установить переключатель в положение “Split into Columns” (Разбить на столбцы) или “Split into Rows” (Разбить на строки) и нажать кнопку ОК. 
1.2 Карты изображения

Как известно в качестве гиперссылки при создании 
Web-страниц может использоваться слово, предложение, рисунок. 5


При этом, по щелчку по этому рисунку будет загружаться Web-страница, связанная с ним. 
Карты изображений отличаются от обычных рисунков-ссылок тем что, карты изображений разделены на области, каждая из которых загружает отдельный файл. Карты изображений могут быть различными: круг, квадрат, многоугольник. 
Для создания карт изображений используются следующие кнопки панели инструментов “Pictures” (Рисунки): “Select” (Выбрать), “Rectangle” (Прямоугольник), “Circle” (Круг), “Polygon” (Многоугольник) и “Highlight Hotspot” (Выделить активную область).
Лист

1.3 Формы 

Формы предназначены для интерактивного общения с посетителями сайта. К примеру, если необходимо сделать гостевую книгу или страницу, где посетители бы высказывали свое мнение или указывали на ошибки в сайте, либо, чтобы посетители дополняли сайт.
Стандарт, который определяет, как посетители взаимодействуют с web-узлом, назван CGI-Common Gateway Interface (Общий интерфейс шлюзов). Программы сервера, имеющие дело с входной информацией типа форм, называются скриптами CGI и написаны в соответствии со спецификациями CGI. С помощью форм можно получить почти любую информацию от посетителей. В каждой форме имеется как минимум два элемента или так называемые поля формы - поле для ввода текста или выбора варианта и кнопка “Отправить”, инициирующая запись результатов из формы в файл или в программу обработки на сервере. Каждая форма состоит из элементов, данные из которых при нажатии на кнопку, завершающую форму, совершают однородное действие - или все вместе отправляются на сервер или все разом очищаются. FrontPage предлагает следующие поля форм: 
· однострочное текстовое поле (One-line text box) ;
· прокручивающееся текстовое окно (Scrolling text box);
 ;
· флажок (Check box) ;
· переключатель (Radio button) ;
· раскрывающийся список (Drop-down menu) ;
· нажимающуюся кнопку (Push button) [image: ];
· графическую кнопку (Image).  
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Каждое из этих полей может быть одним из составляющих элементом формы, а может в сочетании с кнопкой завершения быть отдельной формой.
Для того чтобы создать форму с нуля в необходимо сначала открыть существующую или создать новую Web-страницу, затем щелкнуть в том месте страницы, где необходимо вставить форму и выбрать пункт меню Insert => Form => Form.
Поля формы добавляются с помощью того же пункта меню Insert => Form => One-Line Text Box (Текстовое поле), либо Scrolling Text Box (Текстовое окно), либо Check Box (Флажок), либо Radio Button (Переключатель), либо Drop-Down Menu (Раскрывающийся список), либо Push Button (Кнопка).Лист

Для того чтобы открыть диалоговое окно “Form Properties” (Свойства формы) необходимо выбрать пункт меню Insert => Form => Properties (Вставка => Форма => Свойства), либо щелкнуть правой кнопкой мыши по форме и выбрать в контекстном меню “Form Properties”. Появится диалоговое окно “Form Properties” (Свойства формы).
Основные поля формы. Секция “Where to store results?” (Где сохранить результаты ?) диалогового окна “Form Properties” содержит альтернативные опции:
1) “Send to” (Послать в). Здесь задается обработчик формы по умолчанию, для этого предусмотрены два поля:
- “File name” (Имя файла). Данные из формы могут быть сохранены в текстовом файле на сервере. По умолчанию его имя и путь установлены на закрытую папку, такую как private/feedback.txt. Чтобы задать для сохранения другой файл, можно ввести его относительный URL или нажать кнопку “Browse” (Обзор) и выбрать любую другую страницу в текущем сайте.
- “E-mail address” (Адрес электронной почты). Здесь обработчик формы предоставляет возможность послать файл результатов по электронной почте. Параметры сообщения выбираются в описанном ниже диалоговом окне “Options for Saving Results of a Form” (Опции сохранения данных формы).
2) “Send to other” (Послать другому). Здесь в качестве “другого” варианта предоставляется на выбор один из трех обработчиков формы, а именно “Custom handler” (Пользовательский обработчик) и два обработчика  Microsoft FrontPage. Необходимо поставить переключатель в положение “Send to other” и выбрать опцию из раскрывающегося списка:
· “Custom ISAPI, NSAPI, or CGI Script” (Пользовательский скрипт ISAPI, NSAPI или CGI). Эти скрипты являются программными компонентами на Web-сервере, обрабатывающими предоставленную формой информацию. 7


Смысл создания собственных скриптов состоит в расширении функциональных возможностей Web-сайта сверх того, чего можно достичь с применением компонентов Microsoft FrontPage. Лист

- “Discussion Form Handler” (Обработчик дискуссионной формы). Этот обработчик предоставляет пользователям возможность участия в Web-дискуссиях. Microsoft FrontPage располагает основными инструментами администрирования дискуссионных групп. Дискуссионный компонент “Discussion Component” собирает информацию из формы, формирует из нее HTML-страницу, запоминает страницу на Web-сервере и добавляет ее в оглавление и указатель статей. Разумеется, с его помощью можно собирать и записывать на Web-сервер и любую другую информацию из других форм.Лист

- “Registration Form Handler” (Обработчик регистрационной формы). Это компонент, позволяющий пользователям регистрироваться на предлагаемые на сайте услуги. Он добавляет в базу данных подписчиков услуги, сведения о новом пользователе, а затем выбирает из формы остальную информацию и сохраняет ее на Web-сервере. 
3) “Send to database” (Сохранение результатов в базе данных). 
Помимо этого, в диалоговом окне “Form Properties” в секции “Form properties”  присутствуют еще два поля и кнопка: 
- “Form name” (Имя формы). Если установлен для формы пользовательский обработчик, то в этом поле можно при необходимости указать ее имя, на которое обработчик будет ссылаться.
- “Target frame” (Целевой фрейм). Здесь можно выбрать фрейм для отображения результатов формы. Можно непосредственно ввести имя фрейма или использовать для его поиска кнопку “Target Frame” (Справа от этого поля).
- “Options” (Опции). Последний элемент диалогового окна ”Form Properties” - кнопка “Options” (Опции), предназначенная для конфигурирования различных параметров сохранения результатов формы. При нажатии этой кнопки появится диалоговое окно “Options for Saving Results of a Form” (Опции сохранения результатов формы), имеющее четыре вкладки: “File Results” (Файл данных), “E-mail Results” (Результаты по почте), “Confirmation Page” (Страница подтверждения) и “Saved Fields” (Сохраняемые поля).
- “Advanced” (Дополнительно). Эта кнопка позволяет установить скрытые поля. Они необходимы только в том случае, если используются CGI-сценарии для обработки результатов формы.



8

Список использованных источниковЛист


1 Майкл, А. Создание Web-страниц с помощью MS Office 97 /А. Майкл. — М.: БИНОМ, 1998. — 480 с.
2 Рэндел, Н. Microsoft FrontPage в подлиннике / Н. Рэндел, Д. Джонс — СПб.: BHV- Санкт-Петербург, 1997. — 432 с.
3 Хестер, Н. Front Page 2002 для Windows / Хестер Нолан  – М.: ДМК Пресс, 2002. – 448 с. – ISBN 5-94074-117-7.
4 Основы Web-технологий / П.Б. Храмцов, С.А. Брик, А.М. Русак, А.И. Сурин; под редакцией П.Б. Храмцова. – М.: ИНТУИТ.РУ ”Интернет-Университет Информационных Технологий”, 2003. – 512 с. – ISBN 5-9556-0001-9.
5 Форгаагд, Р. FrontPage98. Русское руководство FrontPage [Электронный ресурс]: руководство  по созданию Web-сайтов/ Рэнди Форгаагд, 2004. - Режим доступа: WWW.URL: http://webmaster.yartop.ru/desing/webe/webe5/webe5-01.html.
6 Редактор FrontPage [Электронный ресурс]: руководство  по созданию Web-сайтов, 2004. - Режим доступа: WWW.URL: http://crimegen.boom.ru/FP1.htm.


9

Приложение А Лист

(справочное) 
HTML-код Web-сайта


HTML-код файла index.html

<html>
<head>
<title>index</title>
<meta name="GENERATOR" content="Microsoft FrontPage 4.0">
<meta name="ProgId" content="FrontPage.Editor.Document">
</head>

<frameset rows="85,*">
  <frame name="banner" scrolling="no" noresize target="contents" src="электронный_гипертестовый_учебни.htm">
  <frameset cols="210,*">
    <frame name="contents" target="main" src="содержание.htm">
    <frame name="main" src="пр.htm" target="_self">
  </frameset>
  <noframes>
  <body>
  <p>This page uses frames, but your browser doesn't support them.</p>
  </body>
  </noframes>
</frameset>
</html>

   HTML-код фреймовой Web-страницы Сети1.html

<html>
<head>
<meta http-equiv="Content-Language" content="ru">
<meta http-equiv="Content-Type" content="text/html; charset=windows-1251">
<meta name="GENERATOR" content="Microsoft FrontPage 4.0">
<meta name="ProgId" content="FrontPage.Editor.Document">
<title>Содержание</title>
<base target="main">
</head>
<body bgcolor="#66FFCC">
<p align="center" style="line-height: 100%; margin-top: 0; margin-bottom: 0"><font size="4" face="Times New Roman">Содержание</font></p>
<p align="center" style="line-height: 100%; margin-top: 0; margin-bottom: 0">&nbsp;</p>
<p align="justify" style="line-height: 100%; margin-top: 0; margin-bottom: 0"><font size="4" face="Times New Roman"><a href="Глава%201.htm" target="main">1&nbsp;
</a></font><font size="3"><a href="содер2.htm" target="contents"><span style="mso-bidi-font-size: 12.0pt; mso-fareast-font-family: Times New Roman; mso-ansi-language: RU; mso-fareast-language: RU; mso-bidi-language: AR-SA">Общие
сведения о вычислительных сетях</span></a></font></p>
<p align="justify" style="line-height: 100%; margin-top: 0; margin-bottom: 0">&nbsp;</p>
<p align="justify" style="line-height: 100%; margin-top: 0; margin-bottom: 0"><a href="Глава%202.htm"><font size="3">2&nbsp;

<span style="mso-bidi-font-size: 12.0pt; mso-fareast-font-family: Times New Roman; mso-ansi-language: RU; mso-fareast-language: RU; mso-bidi-language: AR-SA">Взаимодействие
открытых систем</span></font></a></p>
<p align="justify" style="line-height: 100%; margin-top: 0; margin-bottom: 0">&nbsp;</p>10

<p align="justify" style="line-height: 100%; margin-top: 0; margin-bottom: 0"><span style="mso-bidi-font-size: 12.0pt; mso-fareast-font-family: Times New Roman; mso-ansi-language: RU; mso-fareast-language: RU; mso-bidi-language: AR-SA"><font size="3"><a href="file:///C:/Лилькины%20Документы/РАБОТА/АППАРАТНЫЙ/Сети/Сетевые%20информационные%20технологии/проба/111/Глава%203.htm">3&nbsp;Лист

Объединение сетей с помощью мостов, <span style="letter-spacing: -.3pt; mso-bidi-font-size: 12.0pt; mso-fareast-font-family: Times New Roman; mso-ansi-language: RU; mso-fareast-language: RU; mso-bidi-language: AR-SA">коммутаторов
и маршрутизаторов</span></a></font></span></p>
<p align="justify" style="line-height: 100%; margin-top: 0; margin-bottom: 0">&nbsp;</p>
<p align="justify" style="line-height: 100%; margin-top: 0; margin-bottom: 0"><span style="mso-bidi-font-size: 12.0pt; mso-fareast-font-family: Times New Roman; mso-ansi-language: RU; mso-fareast-language: RU; mso-bidi-language: AR-SA"><font size="3"><a href="file:///C:/Лилькины%20Документы/РАБОТА/АППАРАТНЫЙ/Сети/Сетевые%20информационные%20технологии/проба/111/Глава%204.htm">4
Базовые
технологии локаль</a></font></span><font size="3"><a href="file:///C:/Лилькины%20Документы/РАБОТА/АППАРАТНЫЙ/Сети/Сетевые%20информационные%20технологии/проба/111/Глава%204.htm"><span style="mso-bidi-font-size: 12.0pt; mso-fareast-font-family: Times New Roman; mso-ansi-language: RU; mso-fareast-language: RU; mso-bidi-language: AR-SA">ных сетей</span></a></font></p>
<p align="justify" style="line-height: 100%; margin-top: 0; margin-bottom: 0">&nbsp;</p>
<p align="justify" style="line-height: 100%; margin-top: 0; margin-bottom: 0"><span style="mso-bidi-font-size: 12.0pt; mso-fareast-font-family: Times New Roman; color: black; mso-ansi-language: RU; mso-fareast-language: RU; mso-bidi-language: AR-SA"><font size="3"><a href="file:///C:/Лилькины%20Документы/РАБОТА/АППАРАТНЫЙ/Сети/Сетевые%20информационные%20технологии/проба/111/Глава%205.htm">5
Основы </a></font> </span><font size="3"><a href="file:///C:/Лилькины%20Документы/РАБОТА/АППАРАТНЫЙ/Сети/Сетевые%20информационные%20технологии/проба/111/Глава%205.htm"><span style="mso-bidi-font-size: 12.0pt; mso-fareast-font-family: Times New Roman; color: black; mso-fareast-language: RU; mso-bidi-language: AR-SA">TCP/IP</span></a></font></p>
<p align="justify" style="line-height: 100%; margin-top: 0; margin-bottom: 0">&nbsp;</p>
<p align="justify" style="line-height: 100%; margin-top: 0; margin-bottom: 0"><font size="3"><span style="mso-bidi-font-size: 12.0pt; mso-fareast-font-family: Times New Roman; mso-ansi-language: RU; mso-fareast-language: RU; mso-bidi-language: AR-SA"><a href="file:///C:/Лилькины%20Документы/РАБОТА/АППАРАТНЫЙ/Сети/Сетевые%20информационные%20технологии/проба/111/Глава%206.htm">6
Информационные
сервисы </a> </span><a href="file:///C:/Лилькины%20Документы/РАБОТА/АППАРАТНЫЙ/Сети/Сетевые%20информационные%20технологии/проба/111/Глава%206.htm"><span lang="EN-US" style="mso-bidi-font-size: 12.0pt; mso-fareast-font-family: Times New Roman; mso-ansi-language: EN-US; mso-fareast-language: RU; mso-bidi-language: AR-SA">Internet</span></a></font></p>

<p align="justify" style="line-height: 100%; margin-top: 0; margin-bottom: 0"><font size="3">&nbsp;</font></p>
<p align="justify" style="line-height: 100%; margin-top: 0; margin-bottom: 0"><font size="3"><a href="форма.htm" target="_blank">Анкета
студента</a></font></p>

</body>

</html>
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HTML-код фреймовой Web-страницы Сети2.html

html>

<head>
<meta http-equiv="Content-Type" content="text/html; charset=windows-1251">
<meta name="GENERATOR" content="Microsoft FrontPage 4.0">
<meta name="ProgId" content="FrontPage.Editor.Document">
<title>New Page 4</title>
<base target="_self">
</head>

<body bgcolor="#FFCCCC">

<p style="word-spacing: 0; margin: 0" align="justify"><font size="4"><span style="mso-bidi-font-size: 12.0pt; color: black; letter-spacing: -.2pt">Учебное
пособие посвящено изучению вычислительных
се</span><span style="mso-bidi-font-size: 12.0pt; color: black; letter-spacing: -.15pt">тей:
рассматривается классификация
вычислительных сетей, сетевые тополо</span><span style="mso-bidi-font-size: 12.0pt; color: black; letter-spacing: -.25pt">гии
и методы доступа к среде передачи данных,
эталонная модель взаимодействия открытых
систем.&nbsp; </span></font></p>

<p style="word-spacing: 0; margin: 0" align="justify">&nbsp;</p>

<p style="word-spacing: 0; margin: 0" align="justify">&nbsp;</p>

<p style="word-spacing: 0; margin: 0" align="justify"><font size="4"><span style="mso-bidi-font-size: 12.0pt; color: black; letter-spacing: -.25pt"> Приведены сведения об устройствах
объединения сетей: </span><span style="mso-bidi-font-size: 12.0pt; color: black; letter-spacing: -.2pt">концентраторах,
мостах, коммутаторах и маршрутизаторах.
Приводится классификация стандартных
протоколов, о</span><span style="mso-bidi-font-size: 12.0pt; color: black; letter-spacing: -.1pt">собое
внимание уделяется протоколам </span><span lang="EN-US" style="mso-bidi-font-size: 12.0pt; color: black; letter-spacing: -.1pt; mso-ansi-language: EN-US">Internet</span><span style="mso-bidi-font-size: 12.0pt; color: black; letter-spacing: -.1pt">
сетевого и транспортного </span><span style="mso-bidi-font-size: 12.0pt; color: black; letter-spacing: -.25pt">уровней.Лист

</span><span style="mso-bidi-font-size: 12.0pt; color: black">Рассмотрены
различные информационные сервисы </span><span lang="EN-US" style="mso-bidi-font-size: 12.0pt; color: black; mso-ansi-language: EN-US">Internet</span><span style="mso-bidi-font-size: 12.0pt; color: black">:
служба </span><span lang="EN-US" style="mso-bidi-font-size: 12.0pt; color: black; mso-ansi-language: EN-US">WWW</span><span style="mso-bidi-font-size: 12.0pt; color: black">,
система доменной адресации, электронная
почта, универсальный идентификатор
ресурсов </span><span lang="EN-US" style="mso-bidi-font-size: 12.0pt; color: black; mso-ansi-language: EN-US">URI</span><span style="mso-bidi-font-size: 12.0pt; color: black">
и т.д. Раскрыты основы языка гипертекстовой
разметки </span><span lang="EN-US" style="mso-bidi-font-size: 12.0pt; color: black; mso-ansi-language: EN-US">HTML</span><span style="mso-bidi-font-size: 12.0pt; color: black">.</span></font><font size="4"><span style="mso-bidi-font-size: 12.0pt"><o:p>
 <map name="FPMap0">
 <area href="форма.htm" shape="circle" coords="27, 28, 22"></map><img border="0"  12



src="BD06790_.WMF" width="152" height="128" align="right" usemap="#FPMap0"></span></font></p>


<p style="word-spacing: 0; margin: 0" align="justify">&nbsp;</p>

<p style="word-spacing: 0; margin: 0" align="justify"><font size="4"><span style="mso-bidi-font-size: 12.0pt"></o:p>
</span></font></p>

<p align="justify" style="word-spacing: 0; margin: 0"><span style="mso-bidi-font-size: 10.0pt"><font size="4">Учебное
пособие предназначено для студентов</font></span><span style="mso-bidi-font-size: 10.0pt"><font size="4">,
обучающихся по программам высшего
образования по специальности 220400, при
изучении дисци</font></span><span style="mso-bidi-font-size: 10.0pt"><font size="4">плины &quot;Сети ЭВМ и
телекоммуникации&quot;.</font></span></p>
<p><span style="font-size:14.0pt;mso-bidi-font-size:10.0pt"><o:p>
</span><span style="font-size:14.0pt;mso-bidi-font-size:10.0pt"></o:p>
</span></p>
</body>
</html>
Лист

HTML-код фреймовой Web-страницы Сети3.html

<html>

<head>
<meta http-equiv="Content-Language" content="ru">
<meta http-equiv="Content-Type" content="text/html; charset=windows-1251">
<meta name="GENERATOR" content="Microsoft FrontPage 4.0">
<meta name="ProgId" content="FrontPage.Editor.Document">
<title>Электронный гипертестовый учебник по
дисциплине</title>
<base target="contents">
</head>

<body bgcolor="#CCCCFF">

<p align="center"><font size="5">Электронный
гипертестовый учебник по дисциплине &quot;Сети
ЭВМ и телекоммуникации&quot;</font></p>

</body>

</html> 13
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Приложение Б
(справочное)
Контрольный пример 
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Рисунок Б.1 – Главная страница Web-сайта
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Рисунок Б.2 – Организация закладок внутри фреймсета14
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Рисунок Б.3 – Работа с содержанием гипертекстового учебника
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Рисунок Б.4 – Гостевая страница Web-сайта 15
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